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TOPIC1: DEVELOPER TAB

Language
Ease of Access
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Customize Ribbon

'l All Chart Types...
Borders
Calculate Now
Center
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z
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Save as Adobe
PDF
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Close

Account
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Delete Sheet Rows
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Font Color
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Editing
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Page Layout
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Review

ACROBAT

File Home Insert

Page Layout
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Review

View Help  ACROBAT ,O Tell me what you want to do

Qj r .\_-I Record Macro

= Er 5 Use Relative References
Visual Macros

Basic ! Macro Security

Code

B

Al ~

<] = Properties @ 77 Import
had -l O View Code ) Expansion Packs
Add- Excel COM Insert . Source |
ins  Add-ins Add-ins - Run Dialog
Add-ins Controls HML
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TOPIC2: CREATE CUSTOM LIST FOR AUTOFILL

1. File>Option>
2. Advanced > General > Edit Custom Lists

T LML AL IR VLD

Ease of Access

Advanced ra

Customize Ribbon [[1 1gnore ather applications that use Dynamic Data Exchange (DDE)

Quick Access Toolbar Ask to update automatic links

[ Show add-in user interface errors
Add-ins . .
Scale content for A4 or 8.5 x 11" paper sizes
Trust Center At startup, open all files in:
Web Options...

Enable multi-threaded processing

Create lists for use in sorts and fill sequencps: | Edit Custom Lists...

Lotus compatibility

3. Typealistand when finished, click ADD.

Custom Lists ? *

Custom Lists

Custom lists: List entries:
MEW LIST Isnin Add
Sun, Maon, Tue, Wed, Thu, Fri, Sat Selasa
Sunday, Manday, Tuesday, Wednes Rabu Delete
Jan, Feb, Mar, Apr, May, Jun, Jul, AL Khamis
January, February, March, April, Ma Jumaat
Sun, Maon, Tue, Wed, Thu, Fri, Sat Sabtu
Sunday, Manday, Tuesday, Wednes Ahad|
Jan, Feb, Mar, Apr, May, Jun, Jul, AL
January, February, March, April, Ma
Press Enter to separate list entries.
Impaort list from cells: + Import

4. You can also import from any list in available worksheet by selecting the list and click
IMPORT
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TOPIC3: VLOOKUP

Use VLOOKUP, one of the lookup and reference functions, when you need to find things in
a table or a range by row. For example, look up a price of an automotive part by the part

number.

=VLOOKUP(value, table, column) // default, approximate match

=VLOOKUP(value, table, column, TRU E) // approximate match

=VLOOKUP(value, table, column, FALSE) // exact match

Produk ID Nama Produk Kategori |Harga

A101 Milo Ais Minuman RM2.90
A102 Milo Tabur Minuman RM3.50
A10 ; Minuman Y/ OOKUPRMS5.90
A104 Milo 3in 1 Minuman RM3.70
B101 Spagetti Makanan RM9.00
B102 Lasagna Makanan RM12.00
B103 Chicken Chop Makanan RM16.00
C101 Roti Canai Makanan RM1.50
C102 Roti Telur Makanan RM2.50
C103 Roti Sardin Makanan RM2.70
c1o4 Roti Kaya Makanan RM2.50
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https://exceljet.net/excel-functions/excel-vlookup-function
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=VLOOKUP(I3,B3:E13,2,FALSE) - COLUMN NO 2

Produk ID Nama Produk Kategori |Harga
Al101 Mg AS——||Minuman RM2.90 Produk ID ‘
A102 Milo Tabur Minuman RM3.50
A103 Milo Shake Minuman RM5.90 Nama Produk =VIDOKUP(I3,B3:E13,2,2) |
Al104 Milo 3in 1 Minuman RM3.70
B101 Spagetti Makanan RMS.00 Kategori | ‘
B102 Lasagna Makanan RM12.00
B103 Chicken Chop Makanan RM16.00 Harga [ |
C101 Roti Canai Makanan RM1.50
C102 Roti Telur Makanan RM2.50 Function Arguments
C103 Roti Sardin Makanan RM2.70 by
C104 Roti Kaya Makanan RM2.50

[E =0

B3ET3 = PAT01""Milo Ais"Min
=2

= TRUE

I+ =

Range_lookup |2

Looks for a value in the leftmost column of a table, and then returns a value in the same row from a column you sp¢
must be sorted in an ascending order.

VLOOKUP From Another Sheet

=VLOOKUP(lookup,sheet!range,column,match)

Change sheet in Table Array

Function Arguments ? s

VLOOKUP

I
1

Lookup_value |

\

Table a rrajk

I
"

Col_index_num

tukarkan sheet
yang dikehendaki
_ dan pilih senarai

Looks for a value in the leftmost column of a table, and then returns a value in the same row from a column you specify. By default, the table
must be sorted in an ascending order.

I=»
"

Range_lookup

Lookup value is the value to be found in the first column of the table, and can be a value, a reference, or
a text string.

Formula result =

Help on this function Cancel

Table array | 'Problem Solving'!'Problem Solving''B3:F3 |2 | =

Press ENTER after selecting Sheet & Data Set
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Excel HLOOKUP Function

HLOOKUP is an Excel function to lookup and retrieve data from a specific row in table. The
"H" in HLOOKUP stands for "horizontal", where lookup values appear in the first row of the
table, moving horizontally to the right. HLOOKUP supports approximate and exact
matching, and wildcards (* ?) for finding partial matches.

Age Saiful Nizam ismail Zuraidi Hashim Taib

Juala RM17,100.00 RM93,500.00 | RM151,200.00 | RM119,850.00 | RM89,450.00 | RM109,200.00
Masukkan Bama Function Arguments

Agen Nizam
Jualan H3,2,FALSE) | Lookup_valtie™ | cl $ = Nizam

Table array | C2:H3 b = {"saiful ","Nizam","
Row_index_ num |2 + = 2
HLOOKUP Range_lookup | FALSE * | = FaLsE

= 93500
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TOPIC4: RECORD MACRO

In the Developer Tab, section Code . Select Record Macro

Fl ¥~ Record Macro | ’ .n. E‘* -1,1' b{ El:
5 a\

ﬁ Use Relative Ref
Visual Macros Add- Excel COM Insert Design

Basic 1. Macro Security ins  Add-ins Add-ins - Mode Tl
Code Add-ins Controls
M11 - Je
| A | B | C | D | E | F
1 |Sales Northern Region - 2015
2
3 |Location Jan Feb Mar Apr May

2. Typethe macro name and description . Rules of name macro are
- Cannot contains space
- Lessthan 255 character
- Cannot begin with a number

Record Macro ? x
hAarro name: z
Macrol
Shortcut key:
Ctrl+

Store macro in:

This Warkbook o

Description: /

0K Cancel

3. Name the macro as highlightformula AND click OK
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4. Go to find select > Go To Special

= AutoSum -
n é '%T p
Fill ~
rmat @l Sort & Find &
- & Llear Filter - Select =

£ Find..

. Replace...

=2 GoTo.

GoTo ggcial...

0 Cormniilae

5. Select formulas and tick numbers.

Go To Special ? *
Select
O Comments O Row differences
O Constants O Column differences
@ Formulas O Precedents
MNumbers O Cependents
|| Text Direct only
|:| Logicals All levels
|:| () Last cell
O Blanks O Visible cells only
O Current region O Conditional formats
O Current array O Data validation
() objects Al
Same

6. Thenfill the selected cell with yellow.
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7. Goto macro again and select STOP RECORDING

ﬂ Ef M stop Recordikg

- [E Use Relative Kéferences
Visual Macros Add-
Basic I. Macro Security ins A
Code )

05 S5top Recording

Record a macro.

Each of the commands you
A perform will be saved into the

macro 50 that you can play them
1 |Sales N back again.

8. Open Visual Basic editor to see the code generated.

> r B Stop Recording
& LJ

Use Relative References

Visual IMacros
Bqic ! Macro Security

Code

Visual Basic (Alt+F11)
Open the Visual Basic editor.

S

9. Thecodeisin modules folder

E Microsoft Visual Basic for Applications - 1005-Excel-3-Sales-Data.xlsx

Eile Edit View |Insert Format Debug Run Tools Add-lns Window Help

HE-d #9 pon @ B2 Y @ n19,colt
Project - VBAProject ﬁl
% 1005-Excel-3-Sales-Dataxlsx - Module1 (Code)
|{General) ™
=B} vBAProject (1005-Excel-3-Sales-Data xlsx) Sub Macrol()
=45 Microsoft Excel Objects '
Sheetl (Morth) ' Macrol Macro
Sheet2 (South) '
Sheet3 (East)
Sheet4 (West) '
Sheet5 (Annual Sales) Windows ("First.xlsm") .Activate
ThisWorkbook Windows ("1005-Excel-3-Sales-Data.xlsx") .Activate

Selection.SpecialCells (x1CellTypeFormulas, 1).Select
With Selection.Interior

E—J@ VBAProje ercise-01-Question (1).xlsm) .Pattern = xl1Solid
1455 Microsoft Excel Objects .PatternColorIndex = xlBhutomatic
Sheetl (Sheetl) .Color = 63535
Sheet2 (Objectives) .TintAndShade = 0
-3 | ThisWorkbook .PatternTintAndShade = 0
=% vBAProject (First.xlsm) End With
Bﬁ Microsoft Excel Objects Range ("B17") .Select
Sheetl (Sheetl) End Sub

Sheet2 (Sheet2)
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10. Create another macro to reset all the formatting.

Record Macro ? X

Macro name:

| Clear

Shorteut key:

e |

Store macro in:
| This Warkbook

Description:

| QK | ‘ Cancel

11. Put cursor to this area to select all cells
I

A B | C | D E

ern Region - 2015
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12. Select nofill

I Home Insert Page Layout Foermulas Data Review
b Cut Calibri AN TE=E= ¥
3 Copy ~

1 - - A === &
¥ Format Painter Iy O - B = = | €=

Theme Colors

EEEEN
s
No Fill |

phoard s Font
- S Sa I I
A B C Standard Colors
es Northern Region-2015 HHE
Mo Fill
tion Jan Feb % More Cc*
-
13. Select any cell and STOP RECORDING
Qj F M stop Recordi
] EI‘ E Use Relat eferences
Visual Macros Add-
Basic I Macro Sec ins A
Code }
05 S5top Recording

Record a macro.

Each of the commands you
perform will be saved into the
macro 50 that you can play them
Sales N back again.

A
1
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TOPIC5: RUN MACRO

Developer tabs select MACRO

File Home Insert  Page Layout

rj Record Macro
Use Relative References

1. Macro Security

Code
View Macros (Alt+F8)

016

See a list of macros you can work
with,

e Tell me more

Select macro and click RUN

Macro

Macro name:

First.xlsm!addT exﬂ

Firstxlsm!addText
CLEARALL

Macrol
Firstxlsm!test

Step Into

dit

Create

Delete

Options...

Macros in: | All Open Workbooks

Description l}

Cancel
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Using BUTTON

1. Insert ANY SHAPE and add TEXT such as RUN

RUN

2. Rightclick on the shape and select Assign Macro

t L2,U44.49 £ 1UMYDL01 L

L2029
f 6,964.01 £ 14,488.03 £ Assign Macro... h 963.91
£ 82,08470 £ 8755468 £ ¢l EditAltText. 306.45
Set as Default Text Box
ﬁﬂ Size and Properties...
&",«‘ Format Shape...
- I
RUN . .. .
O © e
Style Fill  Outline
3. Select Macro and click OK
Assign Macro I ? x
Macro name:
TextBoxLCIickl L Mew
Firstxlsm!addText
CLEARALL Record...
Macrol

Firstxlsm!test

Macros in: | All Open Workbooks

Description
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TOPIC6: MACRO BY CODE

1. Create Module
E Microsoft Visual Basic for Applications - Book1

File Edit View |Insert Format Debug Run Tools Add-Ins Window H
EHEE s 2 as 9 1 s R EFE 2@
Projeq UserForm

B Module N
*3  Class Module

= Procedure...
o] Sheetl (Shee |
------ El Thisworkbook

|{General}

2. Typesub and name of the module AND PRESS ENTER
Sub

|{Genera|}

Sub test()

End Sub

3. Typerange (“al”) =12 and run the code

ﬂ Microsoft Visual Basic for Applications - Book1

File Edit Format Debug Run Tools Add-Ins Window He
EME~A & a0 n @R %S Q)

Project - VBAProject  X| Run Sub/UserForm (F5)

@ 5 @]

|{General}
=B vBAProject (Book1’
E@ Microsoft Excel OF Sub test()
3] Sheetl (Shee
o 3% '] ThisWorkbook range ("al")=12|
E@ Maodules End Sub
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4. Modify the code to range (“al:c6”)=12
%% Book1 - Module1 (Code)

|:General}

Sub test()

Range("al:cﬁP] = 12
End Sub

5. Add second line to range (“b5”)=130 and press ENTER
6. For multiple cell selection, you can also use comma

Range("al:c6,j5") =12
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TOPIC7: DEBUGGING

Check line by line for errors. Trace the code by pressing F8

E Microsoft Visual Basic for Applications - Book1 [break]

File Edit View Insert Format Debug Run Tools Add-lns Window Hel

B~ d g9 b D Y @u
oject - VBAProject 5'
_ | ¥4 Bookt - ModuleT (Code)

L4 |{General}

-84 vBAProject (Book1
145§ Microsoft Excel OF | Sub test()
L o Sheetl (Shee

- %' Thisworkbook Range ("al:cé") = 12
£ Modules Range ("b5") = 130
Lowid Modulel End Sub
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TOPIC 8: SAVING AS MACRO ENABLED WORKBOOK

SAVE AS , SELECT NO IF TO SAVE IN MACRO MODE

Save As
« R
Organize *

= Pictures

= This PC

» ThisPC » Desktop » excel macro

New folder

N
»*

Microsoft Excel

Name

v O

Date modified

No items match your search.

Search excel macro

Type

= o

Size

X

P

when you hover over a folder.

e Macro Recorder 149 - 1...
slator..the Macro Recorder 14...

@ Creative Cloud Fil¢
#& OneDrive

= This PC
- 3D Objects

Microsoft Excel %

The following features cannot be saved in macro-free workbooks:
= VB project

To save a file with these features, click No, and then chi a macro-enabled file type in the File Type list.

m Desktop i K To continue saving as a macro-free workbook, clit
File name: | (161 Yes. ‘ No [ Help
Save as type: | Excel Workbook T
Authors:  user Tags: Addatag

[] Save Thumbnail 3 Banai

angi

2 Nk ks Tools ~ Save Cancel PowerPoint
File name: | First

«ave as type: | Excel Macro-Enabled Workbook
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TOPIC9: EXERCISE

Objectives:
1. Create a Macro that types the following headers on row 1:
D
*First Name A B C
L ast Name ID First Name Last Name

2. Make the headers BOLD!

1

S U1 W N
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TOPIC10: SIMPLE DATAENTRY PROJECT

1. Create this table

| A B C D E F G
1 |First Name Last Name Email Phone Company Designation City
2

2. Highlight Cell A1 to G1

(3
A B C D E F G
1 |First Name Last Name Email Phone Company Designation City |
2

3. Click Insert Table and tick My Table has headers
Create Table ? s

Where is the data for your table?
=5A51:5G%1

[“] My table has headersi’

L3

4. File>Option
5. Customize Ribbon > New Tab and rename to Data Entry

I=»

Rename ? X

Display name: |Data Entrﬂ
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6. Add Form to the new tab

General E‘% Customize the Ribbon.
Formulas . )

Choose commands from: Customize the Ribbon: @
Data

| Commands Mot in the Ribbon 57 | Main Tabs 52
Proofing

[# DrawW BOTaer Grmd -
Save i - Main Tabs

@ Dréw Outside Border Background Remaval
Language 4 Edit Cell Styles

=] Edit Code
Ease of Access 2 Edit Query...

s H
Advanced =1 Email k Dlpraw

End Review.. Page Layout

Customize Ribbon Equal Sign Formulas

Erase Border

Quick Access Toolbar Expand Drawing

ST

A ' Exponentiation Sign V] Review
e K it Drawing to Contents view
Trust Center AL Flip Horizontal Developer N
=] Elio\arical [ Add-ins
o .
FoTward
O Free Rotate [VIACROBAT

(ﬂ Freeform: Scribble
(5 Freeform: Shape
B Freeze Panes

From Access (Legacy) k
From Data Connection Wizard (Leg...
[% From OData Data Feed (Legacy)
E From SQL Server (Legacy)

g From Text (Legacy) *
E% From Web (Legacy)
[Ei From XML Data Import (Legacy)
|f| Group Box (Form Control)

Customizations:

< Help Improve Office? -
| OK | | Cancel |
7. Select table header again (only rowl)
A G H

First Name - Last Name - Email ﬂ Phone ﬂ Company ﬂ Designation ﬂ City

MOHD SAIFULNIZAM BIN ABU BAKAR | 7A¢)



8. Go to Data Entry > Form to generate the form

Sheet1 ? *
First Name: | s | ~ Mew Record
Last MName: | | ‘ Mew |
Email: | | ‘ Delete |
Phone: | | ‘ Restore |
Company: | |

‘ Find Prev |
Designation: | |

i ‘ Find Mext |

a |

‘ Criteria |

‘ Close |

w
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TOPIC11: ADDING STRING OF TEXT TO CELL

1. Create new sub addText and press ENTER
Sub addText()
2. Type range (“al”="saiful”)

Sub addText ()

range ("al")%"saiful"
End Sub

3. Runthecode
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TOPIC12: DEFINE NAME

1. Selectcellinrange.

: X v ok

9
| 10] | | | |

2. Rename to any specific name such as tax.
3. Select the range and type a number let say 12 and CTRL + ENTER

tax i X v A 12

4. Inany empty cell, type =sum(tax)
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TOPIC13: TUTORIAL VBA APPLICATION - USER FORM

1. Create new sheet and rename as DATA
2. Create thistable

A B C D
1 NO NAMA No Kp EMAIL
2
3
4
5
6
7
8
9
10
11
12

3. Open VB Editor. Right click on module, insert > Userform

4 (2 [ End Sub

Private &

Toggle Folders

Dim empty

VBAProject Properties... Shemt o (1T
| Insert b | UserForm
Import File... =] Moc@e
*z  Class Module
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4. Draw form by drag the form editor

FEEMO D
M@ -8

a @ &l[E

5. Draw the exact form below

UserForm
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6. Change the property of each item

Label Type Name
NO Textbox txtNo
NAMA Textbox txtNama
NO KP Textbox txtKP
EMAIL Textbox txtemail

Project - VBAProject

X]

= =[]

=B vBAProject (VBAT.xlsm)
B@ Microsoft Excel Objects
--F] Sheetl (Sheetl)
] Sheet2 (DATA)
El ThisWorkbook
55 Forms
B userForm1
- UserForm2
(- [22] Modules

Al

Properties - txtNo

[txtiio TextBox

Alphabetic Categorized

= Contrals I
Name) xtho |
AutoSize |False A = = ®
AutoTab False
AutoWordSelect | True m = EI = = FE
BackColor |:| &HB00000058

BackStyle 1 - fmBackStyleOpaque

BorderColor B &Hs00000068

BorderStyle 0 - fmBorderStyleMone L\)
ControlSource

ControlTipText

DragBehavior 0 - fmDragBehaviorDisabled

Enabled True

EnterFieldBehavior 0 - fmEnterFieldBehaviorSelectAll

MOHD SAIFULNIZAM BIN ABU BAKAR



Add COMMAND BUTTON and change CAPTION to INPUT and name to cmdInput

s g ~
= =l UserForm1
DR R D
E---@VBAProject[VBAT.xlsm} R R
-5 Micrasoft Excel Objects [ ND o B L
Sheetl (Sheetl) ! .. | ccccoococcaoa
q] Sheet2 (DATA) | [ Lo
@Th\sWorkbook OO - m e
E---&Forms :.N,.C\BIAA.”.”.:::::::::::::::::::::”
[ userformt [ R
. [E userFormz L
(- [77] Modules [

Properties - cmdInput < |

|cmd1nput CommandButton

Alphabetic  Cateqorized

(Name) Contrals I

Accelerator A E E2 ® B
AutoSize False

BackColor [] &H8000000FE: ™M = F B LM
BackStyle 1 - fmBackStyleQ e

Cancel

Caption

ControlTipText

Default False

Enabled True

Font Tahoma

ForeColor Il aHs00000128

Repeat for CLEAR command button with name cmdClear and caption CLEAR
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9. Double click on INPUT command button to add coding

Private Sub cmdInput Click()

Dim emptyline As Long

Sheets ("DATA") .Activate

emptyline = WorksheetFunction.Counth (Range ("L:&")) + 1
Cells (emptyline, 1).Value = txtNo.Value

Cells (emptyline, 2).Value = txtNama.Value

txtKP.Value

Cells (emptyline, 3).Value

txtemail.vValue

Cells (emptyline, 4).Value

txtNo.Value = " "

txtNama.Value = " "

txtKP.Value = " " T
txtemail.value = " "

End Sub

Private Sub cmdClear Click()

txtNo.Value = " "
txtNama.Value = " "
txtKP.Value = " "
txtemail.value = " "

End Sub

10. Run CODE for testing
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